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1 Introduction 
This guide is one of a series on effective statistics for Excel users.  We have an overall guide 
called “Excel for statistics: what you can and cannot do”.  There we explain that Excel is good for 
data entry, organization, and descriptive statistics, i.e. graphs and tables.  We suggest you add a 
statistics package if you need more complicated statistical analyses.  Other “good-practice” 
guides for Excel users are on data entry and graphics. 

Excel’s extensive facilities for tabulating data are called “pivot tables”.  Everyone who is 
considering using Excel for statistical work should know about them.  Those introduced are 
surprised how simple they are, and amazed at their power. 

To construct a pivot table, your data must be in the standard row-column form that Excel calls a 
“list”.  This is also the starting point for those who wish to do simple statistics with Excel, using our 
add-in, called SSC-Stat.  Our tutorial on SSC-Stat emphasizes the importance of “lists” for the 
data layout if you are doing any statistical work.  The key points in that tutorial form a useful 
introduction to this guide for those who are beginners in using Excel for data analysis. 

In Section 2 we give an example of data in list format and also of typical tables.  Excel’s facilities 
for tabulation consist of a wizard to help you produce the initial table, as described in Section 3.  
They are followed by facilities to edit the table, so it is in the desired form for your use.   

These tabulation facilities parallel those for producing a graph.  There you again start with a 
wizard, and then edit the resulting axes, legends and so on.  Graphs are used for two purposes.  
There are exploratory graphs, to help you, in evaluating your data.  Then there are presentation 
graphs that form part of your report to others. 

Tables are the same.  We show in Section 4 that Excel tabulation facilities can help with data 
exploration.  Presentation is also important and we see show how Excel is used to produces 
tables for reports. 

With large data sets the analysis often proceeds in stages.  In this case summaries of the raw 
data become the information for the next part in the analysis.  Producing these summaries is a 
third use of tabulation.  This is sometimes called “aggregating” the data and we give an example 
in Section 4. 

In Section 5 we describe some analyses that need more than Excel’s pivot tables can provide 
easily.  The simplest procedure is then to add a statistics package.  There are many, including 
EpiInfo, SPSS, SAS, or Stata. 
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2 Examples of tables 
Fig. 2a shows some data from a simple survey.  There were 36 farmers from 4 villages.  The 
information in column G is the yield of rice and other columns indicate how much fertilizer they 
applied, and which variety of rice was used. 

Fig. 2a An example of survey data 

 
Figs 2b to 2d show three simple pivot tables.  The first is a one-way table showing how many of 
the 36 farmers used each of the 3 varieties.  This is sometimes called a “tally” because it just 
gives a frequency count.  

Fig. 2b A one-way table of frequencies 

 
 
The second and third are both two-way tables.  Fig. 2c gives the count of farmers using the 3 
varieties in each of the 4 villages.  We will see in a later section how these data can be displayed 
as percentages 
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Fig. 2c A two-way table of frequencies 

 

Fig. 2d gives the mean yield of the farmers in each group.  Using both figures together, we see 
that the 2 farmers who were from village Nanda and used the New variety, had a mean yield of 
59.8 q/ha1 (almost 6 tons per hectare). 

Fig. 2d A two-way table of means 

 
 

So the general idea is that some columns of data may be “categorical”.  These are sometimes 
called “class variables” or “factors”.  Examples of categorical data are 

• Yes/No 
• Excellent/Good/Mediocre/Bad/Awful 
• Young/Middling/Old 
• England/Scotland/Wales/NI 

 

In the survey data shown in Fig. 2a the two columns of categorical data we used were those that 
indicated the village and the variety.  Often, as in the examples above, these columns will be 
given in words, but this is not essential.  In Fig. 2e we have a table with a single categorical 
column, showing the amount of fertilizer applied.  Here we have three “statistics” that give the 
number and percentage of farmers applying each level of fertilizer, and also their mean yield. 

 

                                                      
1 A quintile is 1/10 of a ton. 
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Fig. 2e A table showing three summaries 

 
 

We sometimes distinguish between “ordered categorical data” and “nominal data”.  An example 
above of ordered data is the amount of fertilizer, or “Young/Middling/Old” where we would like the 
table to keep this order and not have the categories in alphabetical order.  With nominal data, 
there is no particular order, so it may not matter what order Excel uses. 

In the two-way table in Fig. 2c, the frequencies are the same as in the last column of Fig. 2b.  
This is the “Total” or “Margin” or “All” column of the table in Fig. 2b.  We usually use the word 
“Total” in this guide.  We see that the totals of a two-way table are one-way tables and so on. 

The word “Total” is not entirely satisfactory, as is seen in Fig. 2d, where it gives the means2 
(rather than the totals) for each village or variety.  This is why some software uses other terms, 
such as the “Margin”. 

 

3 Producing tables 
 

To produce a pivot table, start from the sheet containing the data and use Data => Pivot Table 
and Pivot Chart Report.  This launches the Table Wizard, from where the key step is to define 
the initial layout3 of your proposed table, as shown in Fig. 3a.  Here you specify which 
(categorical) columns will give the rows and columns of the table.  Then you show what is to be 
tabulated.  In this example, we have set up the screen for the table in Fig. 2d above. 

 

                                                      
2 The name can be edited, for example to “Mean”.  Once changed anywhere, then all occurrences within the 
table change automatically. 
3 The pivot table wizard has three steps.  The layout button is on the third step. 
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Fig. 3a One screen from Excel’s pivot table wizard 

 
 

When analyzing a survey you may wish to produce multiple tables on the same sheet.  One way 
is simply to make copies of the original table.  They can then each be modified to present the 
data you would like.  Fig. 3b shows the same information as in Fig. 2c, but modified, to give the 
row and column percentages.  From Fig. 2c there were 7 farmers in Village Nanda, who used the 
Old variety of rice.  From the first table in Fig. 3b we see that they were 50% of the Nanda 
farmers, while the second table informs us that they were 41% of the farmers using this variety. 

Fig. 3b Tables of row and column percentages 

 
To produce the percentages in a table is one example of modifying the information.  One way to 
do this is to right-click anywhere in the table and then choose Field Settings and then Options.  
Alternatively double-click in the cell A3 in Fig. 3b, to go straight to the options menu. 
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4 Using tables 
In this section we indicate how tables are used for data exploration, aggregation and for 
presentation. 

4.1 Exploring the data 
It is useful to look at individual observations in more detail.  This may be because certain 
categories are particularly interesting, or perhaps because they are surprising, and may indicate 
oddities in the data. 

Double clicking on any cell of the table shows all the data for just the observations that make up 
the cell.  They are produced on a new sheet.  This is sometimes called “drill-down”.  An 
alternative way is to right-click on the cell and then choose “Group and Outline, => Show 
Detail” 

As an example, we show the data for the 7 farmers from Nanda that used the Old variety in Fig. 
4a 

Fig. 4a Using the “drill-down” facility to see individual rows of data 

 
 

4.2 Aggregating data 
Data are available at different “levels” in a study.  For the rice survey the information in Fig. 2a is 
all at the “farmer level”.  There may also be information at the “village level”, for example the 
location, distance to a main road, whether there is a school or bank in the village and so on. 

Similarly an educational survey may have some information at the local authority level, the school 
level, the classroom level and the pupil level.  A medical study may have information about 
individual patients and also about the visits that each patient made to a hospital. 

Where information is available at multiple levels, this usually corresponds to multiple tables in a 
database package.  In a spreadsheet the information from each level is often in its own rectangle 
and each level may be on a separate sheet. 

Tabulating the data then provides a powerful tool for moving information from a lower level4.  For 
example, in Fig. 4b we show some summaries that are at “village level”.  For example the mean 
yields in the two villages, Kesen and Niko, are lower than in the other two villages.  We see also 
that the mean fertilizer applied is lower. 

 

                                                      
4 If the SSC-Stat add-in is installed an alternative is the Analysis => Summarise dialogue.  This permits a 
wide range of statistics including percentiles and presents the results as one-way tables, similar to Fig. 4b. 
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Fig. 4b Aggregating data from the farmer to the village level 

 
 

These summaries could now be merged with other data that was collected at the village level. 

4.3 Presenting the summary table 
There are many ways in which the appearance of the information in the table can be changed.  If 
all or part of the table is selected, then the Format menu may be used to format either the data or 
the cells.  This was done in many of the tables given in earlier sections, to specify the width of the 
columns and the number of decimals.   

Fig. 4c Examples of tables after using autoformat 

 

An auto-format or a conditional format can also be used, and two examples are shown in Fig. 4c.  
Once the table is as you would like it, then it can be copied to Word or Powerpoint as part of a 
report or presentation5. 

The name “pivot-table” signifies the idea that the rows can be dragged to become the columns, 
etc.  If you were to decide that a variable was not needed in the table, it can be removed.  And 
other category columns can be added. 

Sometimes a table becomes much clearer if the categories making up the rows or the columns 
are reordered.  An example is in Fig. 4d and shows a three-way table ordered so the villages 
using the new variety are at the top.  The data are also to some extent “triangular” and this 

                                                      
5  Take care, however in copying from Excel.  The default is to copy the whole Excel workbook.  This has 
the advantage that the table can then be edited further from within Word or Powerpoint.  However, this 
may be a heavy overhead if the data set is large.  We often do a “paste special” to copy just the values. 
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corresponds to the fact that farmers growing the new varieties used more fertilizer.  The re-
ordering of the categories in a table can either be done manually6, or using Excel’s Data => 
Sort facility7. 

Fig. 4d A three-way table, with villages in a user-defined order 

 

Categories can also be omitted or grouped8.  There is also flexibility on whether to show all, some 
or none of the totals.  As an example Fig. 4e shows the same as Fig. 4d, but with the villages 
grouped. 

Fig. 4e Data grouped to simplify the presentation 

 
The parallel between the graphs and the tables is made even clearer by the ease with which a 
chart can be produced.  In Fig. 4f we show a table of the mean yields for each level of fertilizer 
and each variety.  The corresponding Pivot chart is in Fig. 4g. 

                                                      
6 Click on the cell to move and drag the yellow section. 
7 You can sort within a pivot table.  Mark the cell, or the  part of the table that will be used and then use 
Data => Sort. 
8 To group categories, select those to group and right-click.  Then choose Groups and Outline => Group. 
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Fig. 4f  Mean yields by fertilizer and variety 

 
These two methods of presentation complement each other.  The table shows the actual values, 
and also has extra columns for the margins.  The graph is easier to assimilate and also has the 
added lines that indicate the trend with increasing fertilizer. 

Fig. 4g Data as in Fig. 4f, given as a pivot chart 
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5 Further topics 
In this section we describe some topics concerned with tables that exceed Excel’s capabilities, at 
least those that can be done easily.  The user can then either struggle with the software, with 
which they are familiar, of move to other software. 

5.1 Other summaries 
Excel permits tables of frequencies, including percentages, or summary statistics.  It includes a 
limited set of summary statistics however.  For example in Fig. 2d we showed a table of the 
mean yield for each variety and village.  There is however no function to produce a pivot table 
with medians.  

An example for the data used in this guide is in Fig. 5a9.  There we see that overall the median 
yield was 41 q/ha, with a quarter of the farmers having a yield in excess of 49 q/ha. 

Fig. 5a A table showing medians and other percentage points 

 
  

5.2 Weighting 
We emphasise the importance of weighting data when constructing tables in the SSC guide titled 
“Approaches to the Analysis of Survey Data”.  Weights are important if the way that units were 
sampled does not reflect their presence in the population.  Usually the weights will be provided as 
an additional column of data.  Statistics packages, such as SPSS permit these weights to be 
used, when calculating summaries in tables.  In Fig. 5b we show the same table as in figure Fig. 
2d, but where the yields have been weighted by the size of each farmer’s field10.  This was also 
recorded as the third column, called Size, in the data shown in Fig. 2a. 

 

                                                      
9 We used Instat+ to produce this figure, and some others in this section.  Other statistics packages, such as 
SPSS could equally have been used. 
10 The way the data were collected is also important if we wish to calculate the means in a way that is 
“fair”.  If farmers were equally likely to be included in the sample, then the weights, used in Fig. 5b should 
be used if we later wish to be fair to each hectare.  If we sampled farmers with probability proportional to 
their field size, then we should not weight again. 
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Fig. 5b Mean yields weighted by the size of the field 

 
 

5.3 Multiple responses 
In some surveys there are multiple response questions.  For example a health survey might 
include the question: 

List the reasons you were away from work during the past month? 

This can alternatively be phrased as a series of “multiple dichotomy” questions, each requiring a 
Yes/No answer, such as: 

Were you away from work during the past month because of: 

• Illness 
• Holiday 
• Children 
• Other reasons 

A simple example on forms of exercise is shown in Fig. 5c.  Here the first columns of data 
correspond to some general questions, the sex and age group of the respondent.  Then the 
multiple response question concerns whether the person did exercise of any of three different 
types in the last week. 

Fig. 5c A simple example of multiple response data 
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Alternatively, in Fig. 5d the information on exercise is coded in a way that corresponds to a 
sequence of simple questions, like “Did you walk?” 

Fig. 5d An alternative input of multiple response data 

 
In Fig. 5e we show the sort of table that might be required.  The new feature of this table is that 
the three columns in Fig. 5d have been recorded as a single dimension of the table.  We see in 
Fig. 5e here that the 8 respondents recorded 11 activities.  The calculation of percentages is also 
more “interesting”, because they may be given either in relation to the number of respondents, or 
the number of responses. 

 

Fig. 5e Number of respondents Fig. 5f Percentage of respondents 

 

 

 
 

For example, in Fig. 5f we see for the males that the percentages for walking jogging and cycling 
are 40%, 40% and 80%.  This corresponds to the fact that 2 out of the 5 males walked or jogged, 
while 4 of them cycled, see Fig. 5e.  In all therefore there were 8 responses for the 5 males, and 
this corresponds to the 160%11. 

 

                                                      
11 We do not suggest that one would usually present such small numbers in percentage terms.  The example 
is used merely to illustrate the concepts. 

 13



5.4 Modelling 
The final themes that we explore are crucial for some studies.  In this guide we have so far 
considered only descriptive statistics.  Often however the data for analysis have been sampled 
from some larger population, and we would like our conclusions to apply to the population and not 
merely be a summary for the particular observations in the sample.   

One aspect of this generalization concerns exactly which tables, or graphs need to be produced 
in a report.  We should try to summarise the data as simply as possible.  However tables that are 
too simplistic may mislead the reader.   

For example we could use a chi-square test with a 2-way table of frequencies, to check whether 
the two categorical variables are related, e.g. Fig. 2c.  If not, then the one-way table in Fig. 2b 
would provide a simpler summary of the data.  Now the more modern approach is called log-
linear modelling.  This is roughly the same as the chi-square test, but is much more genera, 
because it is not limited to just 2-way tables.  All statistics packages include facilities for log-linear 
modelling. 

An second example is the two-way table shown in Fig. 4f, and in graphical form in Fig. 4g.  In 
Fig. 4g the two main lines look close to being parallel.  If a parallel-line model is sufficient then 
the table in Fig. 4f, and the three lines in Fig. 4g are more complicated than is needed12.  In that 
case we challenge the reader to assess whether the graph in Fig. 5g would be sufficient to 
indicate that a unit of fertilizer would increase the yields by an estimated 8.9 units13.  The effect of 
variety would be reported as a small separate table, or perhaps included within the text of the 
report14. 

 

Fig. 5g A simpler graph than Fig. 6d 

 
 

Simple examples, such as the above, are within the framework of what is called “linear models”.  
This includes regression modelling and analysis of variance that are also in all statistics 

                                                      
12 The “comparison of regressions” analysis does indicate the adequacy of the parallel lines model.  There 
is no evidence to support the more complicated model where each variety has a different slope. 
13 It is not sufficient.  Using a statistics package to fit the parallel line model gives a much lower slope of 
5.26 units.  (The reason for the difference is that the improved varieties also tend to have more fertilizer 
added, and so bias the slope, if they are not included in the model.) 
14 The means for zero fertilizer are estimated to be 30.0, 35.7 and 47.8 for the Trad, Old and New. 
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packages.  More recently, many statistics packages also include facilities for “generalized linear 
models”, and these allow the same types of decision to be made for situations where the 
distribution of the variable of interest is other than normal 

5.5 Adding a measure of precision 
Once the data are to be considered as a sample, then it is also useful to give a measure of 
precision15 of the summary values that are presented in tables and graphs.  For example, in 
addition to knowing the effect of fertiliser in the parallel-line model is a slope of 5.26, it is 
sometimes useful to know what degree of confidence can be attached to this value.   

If the data may be assumed to be a simple random sample then the calculation of measures of 
precision is covered in statistics courses and is part of the routine output when using any 
statistics package16.  However many sample surveys are designed in a more complicated way.  It 
is still possible for standard errors to be calculated, but only a few packages, such as Stata or 
SAS include such facilities. 

6 In conclusion 
Apart from the few paragraphs at the end of Section 7, this guide is concerned with descriptive 
statistics.  We suggest that many training courses could cover the topics described here in more 
detail.  This would help trainees to understand basic concepts better17.  The materials covered 
here are also a useful component of data summary and presentation in many real studies. 

The presentation of results from any study is usually a mixture of tables, graphs and results 
quoted in the text.  We give some information on the preparation of good tables for reports in our 
guide titled “Informative presentation of tables graphs and statistics”.  Users are often prepared to 
spend considerable time on making graphs as presentable as possible.  We suggest that the 
preparation of presentable tables is equally important. 

Finally the preparation of tables can be used to motivate the teaching of inference and modelling 
methods as we indicate at the end of Section 5.  

                                                      
15 This is given either in the form of the standard error, or as confidence limits. 
16 The standard error of the slope for the parallel line model is then calculated to be 0.96 so the 95% 
confidence limits for the slope are about 4.30 to 6.22. 
17 We find many who have formal training in statistics but remain confused by percentages, and percentiles.  
They are natural topics to cover when teaching about the tabulation of data. 
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